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Chapter 548

Tests for Multiple
Proportions in a OneWay Design
Introduction
This module calculates the power and sample size for binary data from a one-way design for testing for
differences among response proportions of those groups. This is analogous to the classical one-way ANOVA
design that is used to analyze means. In the case of only two groups, this procedure produces power and sample
size estimates that match those from the two independent-group proportions procedure.
The methods used in this chapter come from Mai and Zhang (2017). They proposed using a likelihood ratio test
that has similar power characteristics to logistic regression.

Technical Details
Test Statistic
Technical details are given in Mai and Zhang (2017).
Suppose we have Ng (g = 1, …, G) subjects in each of G groups for a total of N subjects. Let 𝑌𝑌𝑔𝑔𝑔𝑔 be the binary
response (0/1) of subject j in group g. The response is modeled by the model 𝑌𝑌𝑔𝑔𝑔𝑔 ~𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵�𝑃𝑃𝑔𝑔 �.
The log-likelihood ratio test statistic
𝐺𝐺

� = −2 � 𝑁𝑁𝑔𝑔 �𝑦𝑦�𝑔𝑔 �ln(𝑦𝑦�) − ln�𝑦𝑦�𝑔𝑔 � + �1 − 𝑦𝑦�𝑔𝑔 ��ln(1 − 𝑦𝑦�) − ln�1 − 𝑦𝑦�𝑔𝑔 ����
𝐷𝐷
𝑔𝑔=1

where 𝑦𝑦� is the overall mean of Y and 𝑦𝑦�𝑔𝑔 is the mean of Y in group g.

Under the null hypothesis of equal proportions, this test statistic follows the chi-squared distribution with G – 1
degrees of freedom.
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Effect Size
Cramer’s V is used as a standardized effect size measure. It gives the association between the binary outcome
variable and the group variable as a proportion of the maximum possible variation.
The definition of the effect size is
2

𝐺𝐺

𝑉𝑉 = −2 �

𝑔𝑔=1

𝑁𝑁𝑔𝑔
�𝜇𝜇 �ln(𝜇𝜇0 ) − ln�𝜇𝜇𝑔𝑔 �� + �1 − 𝜇𝜇𝑔𝑔 ��ln(1 − 𝜇𝜇0 ) − ln�1 − 𝜇𝜇𝑔𝑔 ���
𝑁𝑁(𝐺𝐺 − 1) 𝑔𝑔

where 𝜇𝜇g = 𝑃𝑃𝑔𝑔 is the response proportion for group g, and 𝜇𝜇0 is the average response of all groups.
The sample effect size is estimated by

�
𝐷𝐷
𝑉𝑉� = �
𝑁𝑁(𝐺𝐺 − 1)

Power
The power of this test is given by
power = 𝑃𝑃𝑃𝑃{𝐷𝐷 ≥ 𝐶𝐶|𝐻𝐻1 }

= 𝑃𝑃𝑃𝑃{𝜒𝜒 2 (𝑑𝑑𝑑𝑑, 𝛿𝛿) ≥ 𝐶𝐶}

= 1 − Ψdf,δ (𝐶𝐶)

2 (𝐺𝐺
− 1)]
= 1 − ΨG−1,N(G−1)V2 [𝜒𝜒1−𝛼𝛼

where Ψdf,δ is a cumulative distribution function of a noncentral chi-squared random variable with df degrees of
freedom and noncentrality 𝛿𝛿 and C is the critical value from a central chi-squared distribution with degrees of
freedom G – 1 and significance level 1 − 𝛼𝛼.

Sample Size
The above power formula can be used in a binary search to obtain an appropriate value for the sample size.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for. When you choose to solve for Sample Size, the program
searches for the lowest sample size that meets the alpha and power criterion you have specified. The Solve For
parameter is displayed on the vertical axis of the plot.
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Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
equal proportions when in fact the proportions are different.
Values must be between zero and one. Historically, the value of 0.80 (beta = 0.20) was used for power. Now, 0.90
(beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of equal
proportions when in fact the proportions are equal.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size and Group Allocation
G (Number of Groups)
This is the number of groups (arms) whose proportions are being compared. The number of items used in the
Group Allocation boxes is controlled by this number.
Range
G ≥ 2.
Group Allocation Input Type (when Solve For = Power)
Specify how you want to enter the information about how the subjects are allocated to each of the G groups.
Possible options are:
•

Equal (N1 = N2 = ... = NG)
The sample size of every group is Ni. All group sample sizes are equal. Enter one or more values for Ni.

•

Enter group multipliers
Enter a list of group multipliers (r1, r2, ..., rG) and one or more values of Ni. The individual group sample
sizes are found by multiplying the multipliers by Ni. For example, N1 = r1 x Ni.

•

Enter N1, N2, …, NG
Enter a list of group sample sizes, one for each group.

•

Enter columns of Ni's
Select one or more columns of the spreadsheet that each contain a set of group sample sizes going down the
column. Each column is analyzed separately.
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Ni (Sample Size Per Group)
Enter Ni, the number of subjects in each group. The total number of subjects, N, is equal to Ni x (number of
groups).
You can specify a single value or a list.
Single Value
Enter a value for the sample size of all groups. If you enter ‘10’ here and there are five groups, then each group
will be assigned 10 subjects and the total sample size will be 50.
List of Values
A separate power analysis is calculated for each value of n in the list. All analyses assume that the common,
group sample size is Ni.
Range of Ni
Ni > 1
Group Multipliers (r1, r2, …, rG)
Enter a set of G multipliers, one for each group.
The individual group sample sizes is computed as Ni = ceiling[ri x N], where ceiling[y] is the first integer greater
than or equal to y. For example, the multipliers {1, 1, 2, 2.95} and base Ni of 10 would result in the sample sizes
{10, 10, 20, 30}.
Incomplete List
If the number of items in the list is less than G, the missing multipliers are set equal to the last entry in the list.
Range
The items in the list must be positive. The resulting sample sizes must be at least 1.
Ni (Base Sample Size Per Group)
Enter Ni, the base number of subjects in each group. The number of subjects in the group is found by multiplying
this number by the corresponding group multiplier, {r1, r2, ..., rG}, and rounding up to the next integer.
You can specify a single value or a list.
Single Value
Enter a value for the base group sample size.
List of Values
A separate power analysis is calculated for each value of Ni in the list.
Range
Ceiling[N x ri] ≥ 1.
N1, N2, …, NG (List)
Enter a list of G sample sizes, one for each group.
Incomplete List
If the number of items in the list is less than G, the missing sample sizes are set equal to the last entry in the list.
Range
The items in the list must be positive. At least one item in the list must be greater than 1.
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Columns of Ni’s
Enter one or more spreadsheet columns containing vertical lists of group sample sizes.
Press the Spreadsheet icon (directly to the right) to select the columns and then enter the values.
Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Also note that you can
obtain the spreadsheet by selecting “Tools”, then “Input Spreadsheet”, from the menus.
On the spreadsheet, the group sample sizes are entered going down.
Examples (assuming G = 3)
C1
C2
C3
111
1
28
115
20
68
100
30
46
Definition of a Single Column
Each column gives one list. Each column results in a new scenario. The columns are not connected, but all should
have exactly G rows.
Each entry in the list is the sample size of that group.
Incomplete List
If the number of items in the list is less than G, the missing entries are set equal to the last entry in the list.
Valid Entries
All values should be positive integers. At least one value must be greater than one.
Note
The column names (C1, C2, ...) can be changed by clicking on them in the spreadsheet.
Group Allocation Input Type (when Solve For = Sample Size)
Specify how you want to enter the information about how the subjects are allocated to each of the G groups.
Options
•

Equal (N1 = N2 = ... = NG)
All group sample sizes are equal to Ni. The value of Ni will be found by conducting a search.

•

Enter group allocation pattern
Enter an allocation pattern (r1, r2, ..., rG). The pattern consists of a set of G numbers. These numbers will be
rescaled into proportions by dividing each item by the sum of all items. The individual group sample sizes are
found by multiplying these proportions by N (the total sample size) and rounding up.

•

Enter columns of allocation patterns
Select one or more columns of the spreadsheet that each contain a group allocation pattern going down the
column. Each column is analyzed separately.

Group Allocation Pattern (r1, r2, …, rG)
Enter an allocation pattern (r1, r2, ..., rG). The pattern consists of a set of G numbers. These numbers will be
rescaled into proportions of total sample size by dividing each item by the sum of all items. The individual group
sample sizes are found by multiplying these proportions by N (the total sample size) and rounding up.
For example, the pattern {1, 3, 4} will be rescaled to {0.125, 0.375, 0.5}. The group sample sizes will be
constrained to these proportions (within rounding) during the search for the sample configuration that just meets
the power requirement.
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Incomplete List
If the number of items in the list is less than G, the missing numbers are set equal to the last entry in the list.
Range
The items in the list must be positive. The resulting sample sizes must be at least 1.
Columns of Group Allocation Patterns
Enter one or more spreadsheet columns containing vertical lists of group allocation patterns.
Press the Spreadsheet icon (directly to the right) to select the columns and then enter the values.
Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Also note that you can
obtain the spreadsheet by selecting “Tools”, then “Input Spreadsheet”, from the menus.
On the spreadsheet, the group allocation patterns are entered going down.
Examples (assuming G = 3)
C1
C2
C3
1
1
3
1
2
3
3
2
1
Definition of a Single Column
Each column gives one allocation pattern. Each column results in a new scenario. The columns are not connected,
but all should have exactly G rows.
Incomplete List
If the number of items in a list is less than G, the missing numbers are set equal to the last entry in the list before
they are rescaled.
Valid Entries
All values should be positive numbers. You can enter decimal values.
Note
The column names (C1, C2, ...) can be changed by clicking on them in the spreadsheet

Effect Size - P1, P2, ..., PG (Group Proportions)
Pi's Input Type
Specify how you want to enter P1, P2, ..., PG, the response probabilities for each of the G groups.
Options
•

P1, P2, ..., PG
Specify the values of the response probabilities for each group. The differences among these values represent
the effect size that you want to detect.

•

Columns Containing Sets of Pi's
Select one or more columns of the spreadsheet that each contain a set of Pi's going down the column. Each
column is analyzed separately.
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P1, P2, ..., PG
Enter the values of the response probabilities, one for each of the G groups. These entries provide values assumed
by the alternative hypothesis. The null hypothesis assumes that all of the values are equal. The effect size detected
by the study is a function of the differences among these values.
This value is the anticipated mean response probability of all subjects in a particular group.
Range
Each Pi can be any number between 0 and 1. Also, at least one of the values must be different from the rest.
Example
0.2 0.1 0.1 0.1
Incomplete List
If the number of items in a list is less than G, the missing numbers are set equal to the last entry.
Columns Containing Sets of Pi’s
Enter one or more spreadsheet columns containing vertical lists of P1, P2, ..., PG.
Each Pi can be any number between 0 and 1. Also, at least one of the values must be different from the rest.
Press the Spreadsheet icon (directly to the right) to select the columns and then enter the values.
Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Also note that you can
obtain the spreadsheet by selecting “Tools”, then “Input Spreadsheet”, from the menus.
On the spreadsheet, the Pi's are entered going down.
Examples (assuming G = 3)
C1
C2
C3
0.5
0.5
0.5
0.1
0.2
0.3
0.1
0.3
0.4
Definition of a Single Column
Each column gives one set of probabilities. Each column results in a new scenario. The columns are not
connected, but all should have exactly G rows.
Incomplete List
If the number of items in a column is less than G, the missing numbers are set equal to the last entry in the
column.
Valid Entries
Numbers between 0 and 1.
Note
The column names (C1, C2, ...) can be changed by clicking on them in the spreadsheet.
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Example 1 – Determining Power
Researchers are planning a study comparing three heart-rate medications: a standard drug and two experimental
drugs. The experimental drugs are expected to have about the same impact on heart rate.
Each subject will receive an application of only one drug. The response that will be analyzed is whether the heart
rate is above 60 bpm. With the standard drug, this proportion has been about 0.40. The researchers want a sample
size large enough to detect a difference of 0.2 in the response rate. They will use the response proportions of 0.40,
0.20, and 0.20 to represent this difference.
The test will be conducted at the 0.05 significance level. The subjects will be randomly split equally among the
three groups.
What powers are achieved by group sample sizes between 20 and 100?

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alpha ....................................................... 0.05
G (Number of Groups) ............................ 3
Group Allocation Input Type ................... Equal (N1 = N2 = ··· = NG)
Ni (Subjects Per Group) ......................... 20 40 60 80 100
Pi's Input Type ........................................ P1, P2, ..., PG
P1, P2, ..., PG ......................................... 0.4 0.2 0.2

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Number of Groups: 3

Power
0.2867
0.5266
0.7124
0.8367
0.9121

Total
Subjects
Count
N
60
120
180
240
300

Subjects
Per
Group
Ni
20
40
60
80
100

Group
Proportions
Set
Pi
Pi(1)
Pi(1)
Pi(1)
Pi(1)
Pi(1)

Effect
Size
Cramer's
V
0.1482
0.1482
0.1482
0.1482
0.1482

Alpha
0.050
0.050
0.050
0.050
0.050

Set(Set Number): Values
Pi(1): 0.400, 0.200, 0.200
References
Y. Mai and Z.Zhang. 2017. Statistical power analysis for comparing means with binary or count data based on
analogous ANOVA. In L. A. van der Ark, M. Wiberg, S. A. Culpepper, J. A. Douglas, & W.-C. Wang (Eds.),
Quantitative Psychology - The 81st Annual Meeting of the Psychometric Society, Asheville, North Carolina,
2016: Springer.
Z. Zhang and K.H. Yuan. 2018. Practical Statistical Power Analysis: Using WebPower and R. ISDSA Press.
Granger, IN.
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Report Definitions
Power is the probability of rejecting a false null hypothesis.
Total Subject Count N is the total number of subjects in the study.
Subjects Per Group Ni is the number of subjects per group.
Group Proportions Set Pi gives the name and number of the set containing the proportion response for each
group.
Effect Size Cramer's V is a measure of the effect size. It is the association between the outcome variable and the
grouping variable. It is the proportion of the maximum variation in the outcome variable accounted for by the
grouping variable.
Alpha is the significance level of the test: the probability of rejecting the null hypothesis of equal means when it is
true.
Summary Statements ─────────────────────────────────────────────────────────
A sample of 60 subjects, divided among 3 groups, achieves a power of 0.2867. This power assumes a
chi-squared test from an analysis with 2 degrees of freedom is used at a significance level of 0.050. The group
subject counts are 20, 20, 20. The group proportions under the alternative hypothesis are 0.400, 0.200, 0.200.
The effect size is 0.1482.

This report gives the sample size for each value of the other parameters.

This shows the relationship among the design parameters.
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Example 2 – Finding the Sample Size
Continuing with Example 1, the researchers want to determine the sample size corresponding to powers of 0.8 and
0.9.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.8 0.9
Alpha ....................................................... 0.05
G (Number of Groups) ............................ 3
Group Allocation Input Type ................... Equal (N1 = N2 = ··· = NG)
Pi's Input Type ........................................ P1, P2, ..., PG
P1, P2, ..., PG ......................................... 0.4 0.2 0.2

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Number of Groups: 3

Power
0.8053
0.9001

Total
Subjects
Count
N
222
288

Subjects
Per
Group
Ni
ri(1)
ri(1)

Group
Proportions
Set
Pi
Pi(1)
Pi(1)

Effect
Size
Cramer's
V
0.1482
0.1482

Alpha
0.050
0.050

Set(Set Number): Values
ri(1): 0.333, 0.333, 0.333
Pi(1): 0.400, 0.200, 0.200

The sample sizes are 222 for a power of 0.8 and 288 for a power of 0.9. Note that the search routine only searches
designs that have equal group sizes (i.e. that are divisible by 3 since there are 3 groups).
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Example 3 – Comparing Various Effect Sizes
Continuing with Examples 1 and 2, the researchers want to compare the sample size of various sets of group
response probabilities. To do this, they will compare the four sets of probabilities shown in the following table.
The first row is the response rate for the standard medication. The second and third rows give the anticipated
response rates of the experimental medications.
The values in this table must be loaded into the spreadsheet.
Table of Four Sets of Response Probabilities
C1

C2

C3

C4

0.40
0.10
0.10

0.40
0.20
0.20

0.40
0.30
0.30

0.40
0.30
0.10

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 3 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.9
Alpha ....................................................... 0.05
G (Number of Groups) ............................ 3
Group Allocation Input Type ................... Equal (N1 = N2 = ··· = NG)
Pi's Input Type ........................................ Columns containing sets of Pi's
Columns Containing Sets of Pi's ............ C1-C4
The above table must be entered into the spreadsheet and the column names changed to C1 – C4.
Press the Input Spreadsheet icon to the right to view the spreadsheet.

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Number of Groups: 3

Power
0.9039
0.9001
0.9004
0.9038

Total
Subjects
Count
N
108
288
1284
147

Subjects
Per
Group
Ni
ri(1)
ri(1)
ri(1)
ri(1)

Group
Proportions
Set
Pi
C1(1)
C2(2)
C3(3)
C4(4)

Effect
Size
Cramer's
V
0.2436
0.1482
0.0702
0.2088

Alpha
0.050
0.050
0.050
0.050

Set(Set Number): Values
ri(1): 0.333, 0.333, 0.333
C1(1): 0.400, 0.100, 0.100
C2(2): 0.400, 0.200, 0.200
C3(3): 0.400, 0.300, 0.300
C4(4): 0.400, 0.300, 0.100
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Note that the horizontal axis gives the index of the probability set footnote. Thus, ‘1.0’ is column C1(1), ‘2.0’ is
column C2(2), and so on.
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Example 4 – Validation of Power Calculation using Mai and Zhang
(2017)
Mai and Zhang (2017) page 390 present an example in which G = 4, V = 0.15 α = 0.05, and Ni = 25. They
obtained a power of 0.572.
Their example did not provide the individual group response rates. Through trial and error, we found the P1 =
0.475, P2 = P3 = P4 = 0.2 results in V = 0.15, so we will use those values in the validation.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 4 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alpha ....................................................... 0.05
G (Number of Groups) ............................ 4
Group Allocation Input Type ................... Equal (N1 = N2 = ··· = NG)
Ni (Subjects Per Group) ......................... 25
Pi's Input Type ........................................ P1, P2, ..., PG
P1, P2, ..., PG ......................................... 0.475 0.2 0.2 0.2

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Number of Groups: 4

Power
0.5721

Total
Subjects
Count
N
100

Subjects
Per
Group
Ni
25

Group
Proportions
Set
Pi
Pi(1)

Effect
Size
Cramer's
V
0.1500

Alpha
0.050

Set(Set Number): Values
Pi(1): 0.475, 0.200, 0.200, 0.200

The power of 0.5721 matches the published power exactly, so the procedure is validated.
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